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Introduction

Welcome to the Cloud Web Security Getting Sarted Guide. Websense® TRITON™
Cloud Web Security isafully managed service that provides comprehensive and
flexible protection against Web threats such as viruses, spyware, and phishing attacks
aswell as controlling employee Web access.

Cloud Web Security is simple to use and works “out of the box” with adefault policy.
To make full use of its features, however, you should configure your policy or add
new policies. This guide outlines the tasks that you must complete to get Cloud Web
Security filtering your Web traffic.

Further Information

Detailed configuration advice for al Cloud Web Security servicesis available in the
Cloud Web Security Administrator’s Guide that can be downloaded from the Support
area of the Cloud Security portal. Also in the portal, there are answers to frequently
asked questions (FAQs) and knowledge base articles. You should check these
whenever you experience a problem or have a support question.

Getting Started

There arefive steps that must be completed before you can use Cloud Web Security. 1t
isimportant that you follow thesein order:
1 Request aCloud Web Security account (Chapter 2).

Select your deployment method (this may affect which of the following steps are
necessary). (Chapter 3)

3. Configure your firewall to allow and enforce Cloud Web Security connectivity
(Chapter 4).

4. Add your Internet gateway |P addresses to your policy (Chapter 7).
5. Configure end-user authentication, if required (Chapter 8).

Other chapters discuss which browsers and proxies are supported (Chapters 5 and 6),
how to set up roaming users (Chapter 9), and how to tailor your policy for your
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Introduction

organization (Chapter 10). Chapter 11 provides tips for setting up an evaluation, and
Chapter 12 suggests how to prepare your end users for their new Web security system.

Technical Support

If you have any questions during the set up phase, please contact your Websense
reseller or Websense support. Technical information about Websense productsis
available online 24 hours a day, including:

latest release information

searchable Websense Knowledge Base
show-me tutorials

product documents

tips

in-depth technical papers

* ¢ 6 6 o o

Access support on the Web site at:

http://www.websense.com/content/support.aspx

If you create a MyWebsense account, you are prompted to enter all Websense
subscription keys. This helps to ensure ready access to information, aerts, and help
relevant to your Websense products and versions.

The best practiceis to create your MyWebsense account when you first set up your
Cloud Web Security account, so that accessis readily available whenever you need
support or updates.

For additional questions, fill out the online support form at:

http://www.websense.com/content/contact Support.aspx

If your issueis urgent, please call one of the officeslisted below. You will be routed to
the first available technician, who will gladly assist you.

Location Contact information
North America | +1 858-458-2940

France Contact your Websense Reseller. If you cannot locate your Reseller: +33
(0)157323227

Germany Contact your Websense Reseller. If you cannot locate your Reseller: +49
(0) 69517093 47

UK Contact your Websense Reseller. If you cannot locate your Reseller: +44

(0) 20 3024 4401

Rest of Europe | Contact your Websense Reseller. If you cannot locate your Reseller: +44
(0) 20 3024 4401

Middle East Contact your Websense Reseller. If you cannot |ocate your Reseller: +44
(0) 20 3024 4401
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Location Contact information

Africa Contact your Websense Reseller. If you cannot locate your Reseller: +44
(0) 20 3024 4401

Australia/lNZ Contact your Websense Reseller. If you cannot locate your Reseller: 1-
800-881-011, Access Code 800-542-8609

Asia Contact your Websense Reseller. If you cannot locate your Reseller: +86

(10) 5884-4200

Latin America
and Caribbean

Contact your Websense Resdller.
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Requesting a Cloud Web
Security Account

If you are reading this guide, it islikely that you have already enrolled for an
evaluation of either Cloud Email Security, Cloud Web Security, or both and have a
MyWebsense account. If not, see below for details of how to request one.

Existing Cloud Email Security Customers

If you are an existing Websense Cloud Email Security customer or are performing a
Cloud Email Security evaluation, you can request that Cloud Web Security services be
added to your account by contacting Websense Sales (contact details at the front of
this document) or your Websense reseller. Websense Support notifies you by email
when the services are added.

New Customers

If you are new to Websense Cloud Security services, you can request an evaluation
online. For more information, see Requesting an evaluation.

Requesting an evaluation

1. Go to www.websense.com and click Products, then select Web security.
Click Freetrial.

3. Under Register & Download by Websense Cloud Web Security Gateway, click
free evaluation.

4. If you aready have a MyWebsense account, log in on the page that appears. If you
do not have a MyWebsense account, click Register and follow the steps to enter
your details, then return to the Evaluate page and click free evaluation again.

5. Answer the registration questions, then click Continue.

6. Read the terms and conditions by clicking on the link, then check the box
confirming you have read them and click Confirm.
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Requesting a Cloud Web Security Account

Shortly after you click Confirm, you receive a confirmation email telling you
how to proceed.

If you prefer to talk to a representative immediately, inside the U.S,, call 1-800-723-
1166. Outside the U.S,, please visit www.websense.com/global/en/Partners/Channel/
FindPartner/ to locate a reseller.

Registering for Cloud Web Security

1. Click thelink on your confirmation email that says“ Click here to begin the
registration wizard” and then enter the evaluation key that was included in your
confirmation email.

2. Verify or reset your account information as needed.

Hosted Security

Websense Account Registration Step One

Please enter your company details.
Fields in bold must be filled in. Hint: If you require further information about a field, roll your mouse over it.
Company | Acme Inc.
Users/Mailboxes 25

1 Acme Way
Anytown, CA

Address
Post/Zip Code 55555
Country :Un_ltgd _States _,’v"
Company Website | www_acme.com
Main Telephone Number  |555-555-5555
Postmaster email address  |postmaster@acme.com

Webmaster email address  |webmaster@acme com

The postmaster address is used by Hosted Email Security as the originator of
system notification messages.

The webmaster address is used by Hosted Web Security as the originator of
system notification messages.
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Requesting a Cloud Web Security Account

3. Verify or reset your system administrator’s detail s as needed (name, address,
telephone number, email address, and password for the administrator account).
Click Next.

WEBSENSE®

Hosted Security

Websense Account Registration Step Two

Please enter the details of the administrative contact at your organisation. The administrative contactis
the person who will eperate the Websense service. A login account will be created for this person. Once
logged in, this person can create additional Websense login accounts.

Tile  [Ms [v]

Given name of the main contact

at the company (mandatory) dane

Surname of the main contact at

the company (mandatory) Lo

Full name  |Jane Doe
1 Acme Way

Contact Address ~ “"Y=vn. R

PostiZip Code 55555
Country United States V
Job Title | Director of IT
Telephone Number | 555-555-5555x%555

email jdoe@acme com
Login  Your login user name will be your email address
Prsord (twico) seenee LTI
Password policy

Pass Phrase Question What was the name of your first pet? ;vi

Pass Phrase Answer  Cocoa

The Pass Phrase will be used to validate you if you contact our helpdesk by phone. You will need to do this
if you forget your passwaord.

<< Back I [ Reset] [ MNext ==

Note

If you have requested an evaluation for Cloud Email Security aswell as Cloud Web
Security, at this stage of the registration process you are asked to specify your email
settings. For more information, see the Cloud Email Security Getting Started Guide.
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Requesting a Cloud Web Security Account

4. Enter the domain(s) for the account, for example “acme.com”. Enter the primary
domain in the field provided. Click Add Another to add another domain. Click
Next when done.

Hosted Security

Hosted Web Security Registration Step One

If you wish to identify end-users for reporting or policy configuration purposes they can register themselves to|
use the Hosted Web Security service. To do so they must have an email address on one of the domains
entered into your Hosted Web Security policy.

Once your account is enabled you can add domains and also invite individual end-users who are are unable
to reqister themselves, for example, if they do not have an email address within the domains that are defined
in your Hosted Web Security policy. Your email domains should be entered here or can be added to your
account once itis enabled, in which case you may wish to skip this step

New domain = xyzcorp.com Add Anather

acmel12 com

Domains

5. Click Add to enter the |P address for which the service will receive Web requests
(proxied connections). If you prefer, you can do this once connected to the service
and skip to step 9.

Hosted Security

Hosted Web Security Registration Step Two

Hosted Web Security needs to know the IP addresses from which it will receive your web requests (proxied
connections). These will typically be the IP address on the external interfaces of your firewalls. They can be
entered here or added to your account ence it is enabled

Mote that once your account is enabled you can also define sites which will not be proxied, even if the
request originates from an address defined here

Connection name Detail Description

No connections configured

Add
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Requesting a Cloud Web Security Account

6. Enter aname and description for this connection and add either the | P address,
range of addresses, or subnet range for this proxied connection. Thisisusually the
external interface for your firewall. Click Add when you' re done.

WEBSENSE® =
Hosted Security

Add Hosted Web Security Proxied Connection

Mote that once your accountis enabled you can also define sites which will not be proxied, even ifthe
request originates from an address defined here

Input a name and description for this connection and add either the IP address, range of addresses or
subnet range for this proxied connection.

Name Proxy 1
Description Primary Web proxy
Type iSubnet v
1 1 A 1
Sibinet @ By bitrange (CIDR) |25

() By subnet range

7. Click Next to finish the process. A Registration Complete screen appears.

WERBENSE®

Hosted Security

Registration Complete

Thank vou far complefing the Websense enrolment wizard. Please note that the Websense Customer Senices team will now perform a number of security checks and inform
rou by email when your account is enabled

When comglete an email containing fll instructions to enable you 1o stai using he senice will be sent 1o he account administrator email address entered dunng the
enrolment process.

A security check isthen carried out by our engineers. Once complete, your
account is activated and you receive a confirmation email advising you of the next
steps. This normally takes about 1 business day.

Logging on to the Cloud Security portal

When you receive logon information in your confirmation email, log on to the Cloud
Security portal by clicking the link that is provided or visiting www.mailcontrol.com/
login/login_form.mhtml.

Note
J You must have port 443 open on your firewall to accessthe
Cloud Security portal. See Configuring Your Firewall,

page 11.
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Requesting a Cloud Web Security Account

Enter your username and password into the fields provided:

websense®

Y TRITON'

HOSTED SECURITY

User name:

Password:

Forgot my password

Technical Library MyWebsense
Knowledge Base Security Labs

© 1996-2011 Websense, Inc,

The screen that appears lists all the licenses that you have pending for your account.

Nl
@ TRITON" Hostea Security Usor: Admin Two (Crstomer Twa)

Home [ &mai secumy Wab Securty b account settings | & Heb
Suppor PIRE 564569 o m
oy |
[\&) Settings o
Al Tral Account Seftings

Contacts

Account Status | Evsuation Enabled Services | Hosied Emal Seaaity ard Content Conbrol, Hosted Web Securily Gateway
Enrollment Key  7T7TAWLS

Under nonmal creurmstances, these comespand to the cument keenses assocatad with your account

Current Licenses

Contract License type  Services Users | Ordered by | Vabd from | valid Willing
umtil weriud
Tes WebDefere evabuption Intial Husted Web Securily Galeway -] ElackSyicer 8 B Ni&
it Evalaton (Web Protection, Wb fiter) L3 o1 201
TestMadlonyol evshiabon contract | vt Hosted Lmail Security and Lontent Contral W00 |dedspder | 3 F=21] A
Evaluation [Antiviras, Antispam, Content Fiter, Standard [r3 011 011
Enanyption]

To activate alicense, you must accept the terms of your license contract.

Click the contract name to view the contract and review itsterms. If they are
acceptable, close the contract, check the Accept license box, and click Accept. This
enables your account.

You can now configure your Cloud Web Security account. A default policy has been
created for you; click Web Security > Policy Management > Policies to accessiit.
This reflects the most commonly chosen policy options.

You can change your configuration at any time. Just click Account Settingsto enter
the setup area of the portal.

Refer to the Cloud Web Security Administrator’s Guide for instructions on how to
configure policiesfor your account. Click Home > Support > All to access this guide.
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Selecting Your Deployment
Method

The first and most important step to deploying Cloud Web Security isto determine
how to direct your Web traffic through the Cloud Web Security service. There are a
number of methods that you can use. This section provides an overview of each.

Websense Cloud Web Security operates as a proxy service for HTTP, Secure HTTP
(HTTPS), and FTP over HTTP. This means that the browser does not connect directly
to the required server (known as the origin server), but instead connects to a Cloud
Web Security proxy server, which relays the request to the origin server on behalf of
the browser. While doing this, the Cloud Web Security proxy server can examine the
reguest and the response, and make decisions such as whether to allow or block the
request.

Cloud Web Security Proxy Service

Origin server

Browser

1. Local Server

Direct:

Cloud Web Security

proxy server
2. Web Server

nr @7}

- —HTTP
o
=
Internal proxy Server
{optional)
3. Secure Web Server
—Tunnel
2
Gateway 4. FTP Server

.

1 Depending on the browser’s configuration, some requests may still go direct to the
origin server. Thisisindicated in the diagram by the “Local server” box, because
typically, such servers are local to the browser, inside the firewall.

2. Proxied HTTP requests (those that begin “http://") are filtered and checked by
Cloud Web Security then relayed to the origin server as appropriate.

Getting Started Guide » 11



Selecting Your Deployment Method

3. Proxied secure requests (those that begin “ https://") are carried over atunneled
connection. This means that the Cloud Web Security proxy server connectsto the
origin server on the browser’s behalf, but takes no further part in the conversation,
passing data back and forth transparently.

You can choose to enable SSL decryption, in which case the cloud proxy
establishes SSL channels with newer browsers (Internet Explorer 8 or later, and
Firefox 3.5 or later) for HTTPS sites. This enables the proxy to serve the correct
notification page to the user —for example, ablock page if the SSL siteisina
category that the end user is prevented from accessing, or the welcome page for
authentication.

To implement this feature for your end users, you need aroot certificate on each
client machine that acts as a Certificate Authority for SSL requests to the cloud
proxy. For more information, see the Cloud Web Security Administrator’s Guide
or Cloud Security Help.

4. Wheretheorigin server isan FTP server (i.e., the URL begins*“ftp://”), the Cloud
Web Security proxy server acts asagateway, converting the HT TP request sent by
the browser into an FTP conversation with the origin server.

In order for the Cloud Web Security serviceto be effective, your users' browsers must
be configured so that all appropriate requests go through the service. Measures should
also be taken to ensure that other applications are prevented from bypassing the
service.

If you already have a proxy within your network, you should be able to direct it to use
Cloud Web Security in a chained proxy configuration. Otherwise, the browsers
themselves must be configured to use the Cloud Web Security proxy.

Configuring browsers to use Cloud Web Security

If your browsers are to access Websense Cloud Web Security directly (i.e., not through
achained proxy), then we recommend you use a PAC file to configure the browsers.
You can aso install the Websense Web Endpoint to ensure all Web traffic isrouted via
the Cloud Web Security proxy.

The Cloud Web Security PAC file

A proxy automatic configuration (PAC) file defines how Web browsers choose an
appropriate proxy for fetching agiven URL. They are preferable to configuring
browsers manually, because they can be easily deployed and provide more
configurable capabilities than a browser’s own settings.

The PAC file contains a number of global settings and allows you to enter exclusions
of your own (for example, intranet sites) that should not use the Cloud Web Security

proxy.

All supported browsers have the ability to use PAC files. Users may beinstructed how
to set thisup for themselves. Alternatively, in a Windows environment, you can use an
Active Directory Group Policy to configure browsers.
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Selecting Your Deployment Method

Either way, you must tell the browsers to get their PAC file from the Cloud Web
Security service. When configuring browsers to download the PAC file, you can
specify either the standard PAC file or a policy-specific PAC file.

Standard PAC file

When a browser requests a PAC file, if Cloud Web Security knows which policy the
reguester isusing, it deliversthe PAC file for that policy; otherwise it deliversa
standard PAC file. You can retrieve the standard PAC file directly from the following
URL:

http://webdefence.gl obal .blackspider.com:8082/proxy.pac

See the Cloud Web Security Administrator’s Guide or Cloud Security Help for further
information.

Policy-specific PAC file

If Cloud Web Security knows which policy the requester isusing, it deliversthe PAC
file specific to that policy. Alternatively, you can specify the policy-specific PAC file
in the browser configuration. This ensures that the user receives the correct PAC file
regardless of location. The policy-specific PAC file URL can be found in the General
screen for each policy. It looks something like this:

http://webdefence.gl obal .bl ackspi der.com: 8082/proxy.pacZR=xXXXXXXX

Websense Web Endpoint

When Websense Web Endpoint isinstalled on an end user’s machine, it forces the use
of Cloud Web Security for Web filtering. The endpoint al so passes authentication
information to the cloud proxies, enabling secure transparent authentication.

For more information, see Setting up Web Endpoint, page 37.

Configuring a chained proxy

If you already have aproxy server that your users' browsers are configured to use, you
should be able to leave the browsers' settings unchanged and configure your existing
proxy to forward all HTTP, HTTPS, and FTP requests to Cloud Web Security. If your
proxy is capable of using a PAC file, you can use the one provided by Cloud Web
Security. Otherwise, we recommend that you download a copy of the Cloud Web
Security PAC file and duplicate its functionality in your proxy’s configuration.
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Selecting Your Deployment Method

For more information about chained proxy configurations, see Using Chained
Proxies, page 21.

J Note

The Cloud Web Security PAC fileis not static, but is generated to reflect the current
settings of your palicies. If you make policy changes and are not using the PAC filein
your proxy, you may have to change your proxy configuration to match.
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Configuring Your Firewall

Some host and port combinations must be allowed through your firewall in order for
Cloud Web Security to operate correctly. Below is a description of each port.

Port Purpose

8081 Proxy service. Thisisessential. Thisiswherethe Cloud Web Security serviceis
provided.

8082 PAC file. Thisisrequired if your browsers (or proxy) areto fetch their PAC file
from Cloud Web Security.

8088 Authentication Service. Thisisrequired if you are using Websense

Authentication Service for seamless user authentication.

8089 Secure form authentication. Thisisrequired if you are using form-based
authentication to authenticate end users.

80 Notification page components. The default notification pages refer to style
sheets and images served from the Websense Cloud Security platform at http://
www.mailcontrol.com. For these pages to appear correctly, thisWeb siteis
accessed directly (i.e., not through Cloud Web Security).

Unproxied home page (principally for remote users). Although this serviceis
principally for remote users, you may chooseto configureall browsersto usethis
astheir home page. In this case, you need to allow access through your firewall.

Checking browser configuration. This service allows users to check whether
their browser settings are correct for accessing the proxy. The site detects
whether it has been accessed via Cloud Web Security and returns a page
indicating this.

PAC fileand proxy servicefor remote users. Remote users should also use the
PAC file address for port 80 if requesting access from a network that has port
8081 or 8082 locked down.

443 Service administration. Websense's administration portal is similarly
unproxied. Otherwise, it would be possible for you to accidentally block access
and then be unable to rectify the situation.

To guarantee availahility, Cloud Web Security uses Websense's global 1oad balancing
technology to direct traffic across multiple geographic locations. A client using the
service looks up the webdefence.global .blackspider.com record. This record resolves
to the IP address of the nearest location of the Cloud Web Security service.

Static users are typically always served by proxies from the Cloud Web Security
service closest to them. In the event of localized or Internet-wide connectivity issues,
Websense's global load bal ancing technology automatically routes requests to the next
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Configuring Your Firewall

closest location. To makethe most of the resilience offered by thisinfrastructure, users
must be allowed to connect to the entire Cloud Web Security network - those IP
addresses that the service uses now and those that may be deployed in the future.

If you decide to lock down your firewall, you should permit all the IP address ranges
in use by the the Cloud Web Security service for al the above ports. These are
published in an FAQ called “ Service P Addresses.” You can find this FAQ in the
Support area of the Cloud Security portal.

Note
‘/ Websense is constantly expanding this list as we add new capacity to support our
rapidly expanding user base.

If you block port 80, you may want to add an exception for some PCs (those used by
your own I T staff) so that they can use the Cloud Web Security performance monitor.
This monitor compares performance through Cloud Web Security against direct
connection performance. It needs to be able to connect directly to the target sites.
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Configuring Web Browsers
for Cloud Web Security

Cloud Web Security has been tested with most commercially-available Web browsers,
but for support purposes we recommend you use one of the following:
MozillaFirefox 3.x and Firefox 4 on all platforms

Microsoft Internet Explorer 7, 8, and 9 on Microsoft Windows platforms

Safari 3.1 on MacOS X 10.4 (Tiger)

Safari 5.x on MacOS X 10.6

* & o o

Configuring Mozilla Firefox

Configuring Firefox manually

1 Goto Tools> Options> Advanced > Network > Settings.

Connection Settings

Configure Proxies to Access the Internet
() Mo proxy
() Auto-detect proxy settings For this network

() Manual prosy configuration:

(%) futomatic praey configuration URL:

http:jfwebdefence. global blackspider . carm: G082/ pra

a4 l [ Zancel ] [ Help ]
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Configuring Web Browsers for Cloud Web Security

Select Automatic proxy configuration URL.

Insert the path to the PAC file.

Click Reload.

Click OK and click OK again to return to the browser.

a M w DN

Configuring Firefox by Microsoft Active Directory Group Policy

A

Warning

Firefox is not the default or supported Web browser for a Microsoft Active
Directory domain, therefore to configure this browser through Group Policy, you
must install third-party extensions to Group Policy in Active Directory. The
following extensions are not supported by Microsoft, nor are they supported and
endorsed by Websense.

Thefollowing URL containsinformation and extensionsfor Firefox and Group Policy
Objects (GPO):

http://sourceforge.net/projects/firefoxadm

We strongly recommend that you read all available documentation before installing
the Active Directory extensions for Firefox. The above link provides a download of
the FirefoxADM, which isagroup of Active Directory Group Policy templates. Once
you have downloaded the templates, you can install them al; however, the 2 files that
are needed to configure Firefox for Cloud Web Security are:

+ firefoxlock.adm, which is the administrative template for locking down Firefox
settings. See Turning on Group Policy to configure a Web proxy, page 14.

o firefox_startup.vbs, which isthe startup script for locking down Firefox settings.
See Applying the policy, page 15.

Add these 2 filesto AD. They arein the FirefoxADM Startup folder. You should save
and extract these files to an easily accessible folder on the machine that you use to
edit/create the GPO.

Turning on Group Policy to configure a Web proxy

1 Logontoaserver inthe domain, and with administrative permissions, open up
Sart > Programs > Administrative Tools > Active Directory Users &
Computer s and expand your domain.

2. Right click the top-level domain or Organizational Unit where the policy should
be applied, select Properties, then select the Group Policy tab.

3. Create a GPO and give it ameaningful name (Cloud Web Security, for example).

4. Select the newly created GPO and click Edit. Right click Administrative
Templates from the Computer Configuration options.

5. Choose Add/Remove Templates. Click Add and browse to the folder where you
extracted the firefoxlock.adm file.
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6. Click thefirefoxlock.adm file and select Open. Thisinstallsthe firefoxlock.adm
templatein AD. Click Closein the Add/Remove Templates dialog box, refresh
your view and under Computer Configuration > Administrative Templates,
you should see anew section called M ozilla Firefox L ocked Settings.

7. Doubleclick Mozilla Firefox Locked Settings and double-click Proxy Settings.

8. Edit the proxy settingsto direct the browsersto pick up settingsfrom the PAC file,
then select L ocked from the Preference State drop-down.

i Group Policy Dbject Editor i [= 3
Fle  Action  View  Help
< LEEFE &

T Lock FF GPO tpinko [ssdwbisl] . salesdemo, websense.cc
= Computer Configuration

|- (] Software Settings -
= Software installation oy el
=1 (] Windows Seltings Display Properties g
g Seripts (Startup)Shutdown) 2% Tab Behaviour
4SS
-~ T - i Proxy Settings Properties EE
i Sedfing | Explain
1 4 Mogills Firafox Lockad Settings I I { e
s T ytem ¥ Progy Setlings
- [ Metweork '.y
] Priritess
= ¢} User Configuration " Not Configued
B[] Software Sattings (+ Enabled
+1-1 ] Windows Settings " Dizabled
4] Admiristrative Templates T e
Prelerenca Sﬁdﬂumﬂed __'_I J ﬂ oz Exbensions
hoines T
Piosy Setting [ Manual Praxy Corhguration =l
Auseenatic Prosy Configuration URL
[ s
Marwsal Seiting - HT TP Prosy s
[1064 114774
HTTP Pross ot [fen = k| 4|
‘4 | il
| BreviousSetiing | NewSetiog |
0C | Cancsl | 4 |

The Automatic Proxy Configuration URL should point at the PAC file you have
chosen to use (see The Cloud Web Security PAC file, page 12 for more details).

Applying the policy

Note

‘/ Firefox is not native to Active Directory and even though you have installed an
administrative template, it may not be applied the next time GP is refreshed. Thisis
why you should use the firefox_startup.vbs script.

1 Inthe Cloud Web Security GPO, navigate to User Configuration > Windows
Settings > Scripts (logon/logoff) and double-click L ogon to open the L ogon
Properties dialog box.

2. Click Show Filesto open the location of any logon scripts for this GPO. Thisis
empty, because thisis anew GPO. Leave this window open and navigate to the
folder where you extracted the firefox_startup.vbsfile (this should be the same
folder asthe firefoxlock.adm file).
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3.

4,

Copy firefox_startup.vbsto the empty scripts folder you have previously
opened. Close both file locations.

In the Logon Properties dialog box, select Add to open the Add a Script option.
Click Browse and you are shown thefile you have just placed in the scriptsfolder.
Select the firefox_startup.vbs script, click Open, then OK twice to apply this
script to the GPO.

The next time userslog onto amachine, thislogon script directstheir Firefox browsers
to pick up the Firefox defaults set up in the earlier sections.

Turning off the Web proxy using Group Policy

1

5.

Open Active Directory Users & Computers.

Right-click the top-level domain or organization where the policy was originally
applied, Select Properties, then select the Group Policy tab.

Select the original GPO (Cloud Web Security) and click Edit.

Navigateto User Configuration > Administrative Templates> M ozilla Firefox
Default Settings and double-click Proxy Settings.

In the Proxy Settings dialog box, select Not Configured then click OK.

This change becomes active next time the client logs on.

Configuring Internet Explorer

Configuring Internet Explorer manually

1.

Go to Tools > Internet Options and click the Connections tab.
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2. Click LAN Settings.

Automatic configuration

Automatic configuration may override manual settings, To ensure the
use af manual setkings, disable automatic canfiguration.

[ ]automatically detect settings
Ilse aukomatic configuration scripk

Address | httpif/global blackspider. com: S082/F

Proxy server

4 s a prowxy server For wour LAN (These settings will nok apply to
dial-up or ¥PM connections),

[ oK ][ Cancel ]

3. Clear Automatically detect settings, if selected.
To set up aPAC file, select Use automatic configuration script.

5. Enter thelocation of the PAC file in the Address field (see The Cloud Web
Security PAC file, page 12 for more details).

6. Click OK to returnto the Internet Options dialog box.

7. You must now configure settings for VPN and dial-up connections. If you do not,
itislikely that users’ browserswill fall back to a direct connection.
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From the Connections tab, highlight the connection to be configured and click
Settings.

izeneral | Security | Privacy | Content | Connections | Programs | Advanced

To set up an Internet connection, click Setup
Setup,

Dial-up and Yirtual Private Mebwork settings

b websense YRR (default)

Remove...

Setkings
Choose Settings if wou need to configure a promsy
server For a connection,

) Wever dial a connection
i) Dial whenever a network, connection is not present

(%) always dial my defaulk connection

Current Websense VPR

Local Area Mebwork (LAN) settings

LAMN Setkings do nok apply ko dial-up connections, LAMN setkings
hoose Settings above For dial-up settings.

[ (84 ] [ Cancel

8. Apply the same configuration that you set for the LAN connection, as covered in

steps 4-6.

Turning on Group Policy to configure a Web proxy

1.

Log onto aserver in the domain, and with administrative permissions, open up
Sart > Programs > Administrative Tools > Active Directory Users &
Computer s and expand your domain.

Right click the top-level domain or Organizational Unit where the policy should
be applied, select Properties, then select the Group Policy tab.

Create a GPO and give it a meaningful name (Cloud Web Security, for example).
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4. Edit the GPO from the following location. User configuration > Windows
Settings > I nternet Explorer Maintenance > Connection > Automatic
Browser Configuration.

Micrasoft Internet Explorer 5.0 Customization Wirard - Stage 4

Automatic Configuration

Adiprnalic: Coefiguration (2 conba] alows: wou ba makes pdales 10 pou usel machine: aller degloprenl, Yoy
can speciy an URL o 5. NS Re or smoeutopeoy URL, o botin

[ fuslomaticaly detect conliguation selling:

[ Enable sutomatic Conliguation

Yoy G sl B irtaresl in mmoles o8 when Subc-condi will hapasr IF wou basws Lhis wsbus blark, o &l mag,
ahorconfig will ondy happen shien the browser b been stailed and revdgates bo s page

fuglomaticaly configies avary (0 Tz

Auslg-coning LIRL [INS fef
[hm.‘-’shmﬂ.esi.he

fudg-prooy UAL LIS, V5, o PAC ek
mehmmw-.pa:

Bk | Meas e |

5. Select Enable Automatic Configuration.
6. Under Auto-proxy URL (.JS, .JVS, or .PAC file), enter the path to the PAC file.

7. Inthe Automatically configure every field, specify how often the Web browser
should query for the auto-configuration. For example, if you enter 240 minutes,
every 4 hours the Web browser checks for an updated PAC file. If you leave this
field blank or set it to “0", the Web browser is only configured when it is started.

8. Once the configuration is complete, click OK.

Web clients using Internet Explorer pick up the settingsin this GPO the next time that
group policy refreshes, which by default is every 90 minutes for clients and every 5
minutes for Domain Controllers (or the next time a user logs off and on again). You
can change therefresh interval in the default domain policy, or by going to a particul ar
client and entering the following at a command prompt:

gpupdate /force

Turning off the Web proxy using Group Policy

If the policy needs to be reversed, it is not as ssimple as removing the GPO that was
originally applied. | E stores proxy settings in the registry, therefore by removing the
policy, you are keeping the same registry settings; it take another “write” session to re-
configure the proxy settings. To achieve this follow these steps:

1 Logontoaserverinthe Domain, and with administrative permissions, open up
Sart > Programs > Administrative Tools > Active Directory Users &
Computer s and expand your domain.

2. Right click the top-level domain or Organizational Unit where the policy should
be applied, select Properties, then select the Group Policy tab.
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5.
6.

Select the original GPO (Cloud Web Security) and click Edit.

From User configuration > Windows Settings > Internet Explorer
M aintenance > Connection > Automatic Browser Configuration, clear Enable
Automatic Configuration.

From Proxy Settings, clear Enable proxy settings.
Click OK and close the GPO.

The clients update the next time Group Policy refreshes or, as described above, use the
command line at a particular client to achieve this manually.

Configuring Safari manually

Enl I

In Safari, go to Safari > Preferences.

Click on the Advanced icon.

Under Proxies, click Change Settings.

For Mac OS 10.5 and under:

m  For the Configure Proxies option, select Using a PAC file.

= Inthe PAC file URL field, enter the path to the PAC file (See The Cloud Web
Security PAC file, page 12).

s Click Apply Now.
For Mac OS 10.6:

= Under Select aprotocol to configure, select Automatic Proxy
Configuration.

= Inthe Proxy Configuration File URL field, enter the path to the PAC file (See
The Cloud Web Security PAC file, page 12).

s Click OK.
Close and restart Safari.
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Cloud Web Security has been tested with a number of commercially-avail able proxies
in chained proxy configuration. For support purposes, if chained proxy isyour chosen
deployment method, Websense recommends the use of one of the following:

& Microsoft |SA Server or Forefront TMG, page 21
+ Blue Coat ProxySG, page 28
& Squid Proxy, page 31

Microsoft ISA Server or Forefront TMG

A Microsoft® Internet Security and Acceleration (1SA) Server or Forefront™ Threat
Management Gateway (TMG) server can be deployed as a downstream proxy with
Cloud Web Security. You can configure proxy chaining in the following ways:

¢ Basicchaining. The ISA server does not perform any authentication before
forwarding requests to the cloud proxy. The cloud proxy can perform manual
authentication only.

¢ NTLM passthrough. The ISA server isaware of arequirement for NTLM
identification but takes no part in the authentication, forwarding requests to the
cloud proxy which then performs NTLM identification.

o X-Authenticated-User. The ISA server performs user authentication and
forwards requests to the cloud proxy using the X-Authenticated-User header.

Inthisguide, “ISA/TMG” refersto ISA Server and Forefront TM G collectively. When
instructions or information differ for the two products, they are referred to specifically
as“ISA Server” or “Forefront TMG”.

Basic chaining
To set up your ISA/TMG server to chain with the upstream cloud proxy, follow the
instructions below.

1 Logontothel SA/TMG server and open the Server Management console.

2. Under Configuration, open the Networ ks option and select the Web Chaining
tab. Under thistab adefault ruleis present. Leavethisasitis.
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3. Click the Taskstab, then click the Create New Web Chaining Rule link to start
the wizard.

New Web Chaining Rule Wizard : x|

Welcome to the New Web
. it g
lrllcmw-lf socurity & Chaining Rule Wizard
Acceleration Server 2004

Web chaining rules determine whether client requests for
Wwieh cortent are retrieved directly from the specified
destination, routed upstream to an 154 Server, or routed to
an alternate destination.

-- Weh chaming rule narne:

To continue. click Next.

< Back I Mest » I Cancel |

4. Givetherule ameaningful name such as Cloud Web Security, and click Next.

5. Inthe next section, choose the destinations to which this rule applies (in most
cases, it applies to external networks).

New Web Chaining Rule Wizard x|

WwWeb Chaining Rule Destination
Thiz rule will apely to requests zent ta the destinations zpecified in this page

Thiz rule applies to traffic sent to these destinations:

Add...

Edi..

Bemove

s

< Back I Mewt = I Cancel

6. Click Add and select the appropriate network.
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service: webdefence.global .blackspider.com

Mew YWeb Chaining Rule Wizard

Primary Routing

“Yiou can specify the primany route for iegquests that are sent to an upstream prosy
ferer

7. Click Next to specify how requests are to be handled. Thisiswhere you specify
that requests be sent to an upstream server (i.e., Cloud Web Security).
New Web Chaining Rule Wizard x|
Hequest Action
Specify how client requests for content from the specified destination should be
proceszsed.
~ Request Processing
¢ Retrieve requests directly from the specified destination
+ Hediect requests (0 a specified upshieam server
[/ Allow delegstion of basic authentication credentials
" Rediect requests to:
Hosted site: | Birowse:. . |
Bout:
S5L Port:
[ Use automatic disl-up
Help ahout automatic dial-up
< Back I MHest > I Cancel |
8. Select Redirect requeststo a specified upstream server and click Next.
9. OnthePrimary Routing page, specify the address of the Cloud Web Security

Type the name of the server and the port number for the primary route. 1f you want ho
use 3 specific uzer account, bype the name and password,

Bt IEDS‘I
55L Port IEDB‘H

Authentication I j

Server Iwebdefence.g\oba\.blackspider. com Biowse |

[~ Use this account I Setdeoount |

{ Back I Mest > I

Cancel

10. Specify port 8081 for both Port and SSL. Click Next.
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11. Onthe Backup Action page, select the appropriate action for your organization.
Your choice depends on whether you are willing to allow requests to be served
directly, without using Cloud Web Security. Click Next.

New Web Chaining Rule Wizard |

Backup Action
fou can set up a backup action for clients that cannot connect through the:
primary route.

wihen the primary route is unavallable:

™ Retieve iequesls diectly from the specified destination

(o Boute requests to an upstream server

I~ WUse autamstic dialug

Help about automatic dislup

< Back I MHest > I Caticel

12. Review your settings and click Finish.

Configuring exceptions

If there are any hosts that you do not want to use the proxy service, you must
configure an exception for them. Minimally, you should add those hosts that are in the
PAC filethat is downloaded from the Cloud Web Security service (see The Cloud Web
Security PAC file, page 12 for more details).

You should also configure direct access to the Cloud Security portal to allow the
following:

+ Correct display of block pages

o End-user self-registration

If you are using the roaming user home page (http://

home.webdefence.global .blackspider.com/), that should also be configured as an
exception.
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1 To configure exceptions, click Firewall Policy, then select Network Objects

from the Toolbox.

Toolboxr Y Tasks N Help

Protocols

i Users
Content Types

Schedules

PEee®®

Network Dbjects

New = Edit... Delste

[ Metworks
[ Metwork Sets
1 Computers
[ Address Rranges
| Subnets
[# |4 Compuker Sets
1 URL 5eks
[= | Domain Mame Sets
L5 Micrasoft Error Reporting si
1] Syskem Policy allawed Sikes
L5 wreproxied
[ web Listerers

2. Right-click Domain Name Sets and click New Domain Name Set.

WebDefence Unproxied Properties

General |

21|

0 Mame: IWebDefence Un-roxied

i If the DMS is not configured correckly, rules using demain name
"'I') sets may not be applied as expectsd.

Comain names included in Ehis set:

|5 www blackspider .com

home webdefence global blackspider .com
download .microsoft.com
ntservicepack.microsoft.com
cdm.microsoft.com

wustat.windows .com

o windowsupdate.microsoft.com

&

e Rename Delete
Description
[apkional):
(414 I Cancel | Apply |

3. Givethe new set aname (e.g., Cloud Web Security Unproxied).

In the Domain namesincluded in this set section, add all Cloud Web Security
global exceptions (from the Cloud Web Security PAC file). These include the

following Microsoft Windows update sites:

download.microsoft.com
ntservicepack.microsoft.com
cdm.microsoft.com
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wustat .windows.com
windowsupdate.microsoft.com

* .windowsupdate.microsoft.com
update.microsoft.com

* .update.microsoft.com

* .windowsupdate.com

Also, add the following Cloud Security sites:
www.blackspider.com
mailcontrol.com
home.webdefence.global.blackspider.com
webdefence.global .blackspider.com
Include any other exceptions appropriate for your environment.
4. Click OK and Apply changes.

5. Navigate back to the proxy chaining policy you created above, open the policy
and click the To tab.

6. Inthe Exceptions section, click Add.

A 3| | Add Networlc Entities 4 x|
Gereral | Action Te |E=ridging | Metvark entities:
This rule applies to kraffic sent o these destinations: kew - Edi.. Delete
[ Metworks
ﬂExternaI add... | Metwork Sets
| Computers
Edit. .. | 1 Address Ranges
[ Subrets
ﬂl [ Computer Sets
= [ Domain Mame Sets
|3 Microsoft Error Reporting sites
L3 Swstem Policy Allowed Sikes
H ur-proxied
ISR =bCefence Un-proxied
Exceptions: 3 URL Sets
Add...
Edlty . |
Remove |
#dd | Cose I
] e |- |

7. Expand Domain Name Sets, select the domain set you just created (Cloud Web
Security Unproxied), and click Add.

8. Click Close on Add Network Entities.
9. Click OK onthe Web chaining policy and Apply the changes.

Configuring NTLM pass through

To chain your ISA/TMG server with the cloud proxy and perform NTLM

identification:
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1. Follow the stepsin Basic chaining, page 21.
Log on to the Cloud Security portal.

3. Select Web Security > Policy Management > Policies > policy name > Access
Control, then click Edit.

4. Select Always authenticate userson first access, then select NTLM
transparent identification where possible. For more information, see NTLM
identification in the Cloud Security Help.

5. Click Submit.

Configuring X-Authenticated-User chaining

You can pass authentication details from your ISA/TMG server to the cloud proxy via
aplug-in from Websense, Inc. This plug-in allows the cloud proxy to read the
X-Forwarded-For and X-Authenticated-User headers sent by the downstream | SA/
TMG server as part of aproxy chained configuration.

X-Forwarded-For Contains the client | P address

X-Authenticated-User When ISA authentication is turned on, this header
will be populated with the user domain and username
(domain\user).

With this setup, end users can be authenticated transparently by the cloud proxy,
removing an authentication step and improving performance.

Two versions of the plug-in are available:

¢ Websense-AuthForward32.dll for 32-bit ISA/TMG servers
o Websense-AuthForward64.dll for 64-bit ISA/TMG servers.

Zip filesfor both versions are available for download:

1. Log onto your MyWebsense account.

2. Select the Downloads tab.

3. Select Websense Web Security Gateway from the Product drop-down list.
4

Inthelist that appears, expand | SA 32-bit plugin for WCG or | SA 64-bit plugin
for WCG to see the download details. Click the download link to start the
download.

Install the plug-in asfollows:

1. Copy the appropriate Websense-AuthForwar d.dll file (for 32-bit or 64-hit) to
the Microsoft ISA/TMG installation directory. The default directory for thisfileis
C:\Program Files\Microsoft | SA Server for ISA server, or C:\Program
Files\Microsoft Forefront Threat Management Gateway for ForefrontTMG,

For the 32-bit version, install the following filesin the installation directory in
addition to Websense-AuthForwar d32.dll:
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2.

3.

Microsoft.VC90.CRT.manifest
msvem90.dl|

msvcp90.dll

msvcr 90.dll

Open aWindows command prompt and change directory to the installation
directory.

From the command prompt, type

regsvr32 Websense-AuthForward32.dll
(to register the 32-bit plug-in)

regsvr32 Websense-AuthForwardée4.dll

(to register the 64-bit plug-in)
Verify the plug-in was registered in the ISA/TMG management user interface
(Start > Programs > Microsoft | SA Server > | SA Server Management, or
Sart > Programs > Microsoft Forefront TM G > Microsoft Forefront TMG
Management). In the Configuration (for 32-bit) or System (for 64-bit) section,
select Add-ins, then click the Web-filter tab. The WsAuthForward plug-in should
be listed.

To uninstall the plug-in, run the following command in a Windows command prompt
from the ISA/TMG installation directory.

regsvr32 /u Websense-AuthForward32.dll
(to unregister the 32-bit plug-in)

regsvr32 /u Websense-AuthForwardé4.dll
(to unregister the 64-bit plug-in)

Blue Coat ProxySG

Blue Coat ProxySG can be deployed as a downstream proxy with Cloud Web
Security. You can configure proxy chaining in the following ways:

+ Basicchaining. The Blue Coat server does not perform any authentication before

forwarding requests to the cloud proxy. The cloud proxy can perform manual
authentication only.

NTLM pass-through. The Blue Coat server takes no part in authentication,
forwarding requests to the cloud proxy which then performs NTLM identification.

X-Authenticated-User. The Blue Coat server performs user authentication and
forwards requests to the cloud proxy using the X-Authenticated-User header.

Basic chaining

In this case, Blue Coat ProxySG forwards requests to the cloud proxy but performs no
authentication. End users can be authenticated using manual authentication only:
prompting users for a user name and password the first time they access the Internet
through a browser.
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Use the Blue Coat Management Console to forward reguests to the cloud proxy as
follows:

1. IntheBlue Coat Management Console Configuration tab, select Forwarding >
Forwarding Hosts.

2. Select Install from Text Editor from the drop-down, and then click Install.

3. Update the Forwarding Hosts configuration file to point an alias name to
webdefence.global .blackspider.com, port 8081. For example, if you choose the
alias name ‘Websense _Proxy’, enter the following at the end of the ‘ Forwarding
host configuration’ section:

fwd _host Websense Proxy webdefence.global.blackspider.com
http=8081

4. Add thefollowing to the end of the ‘Default fail-over sequence’ section:

sequence alias name

replacing alias name with the alias name that you chose in step 3.
5. When you have finished editing, click I nstall.

6. Inthe Blue Coat Management Console Configuration tab, click Policy and select
Visual Policy Manager. Click Launch.

7. Inthe Policy menu, select Add Forwarding Layer and enter an appropriate
policy namein the Add New Layer dialog box.

8. Select the Forwarding Layer tab that is created. The Source, Destination, and
Service column entries should be Any (the default).

9. Right-click the areain the Action column, and select Set.

10. Select the alias name that you created (for example, Websense Proxy) from the
list, and click OK.

11. Right-click the alias name in the Action column and select Edit.

12. Choose the forwarding behavior if your Blue Coat proxy cannot contact the cloud
proxy: either to connect directly, or to refuse the browser request .

13. Click OK.
14. Click Install Palicy in the Blue Coat Visua Policy Manager.

NTLM chaining

To chain Blue Coat ProxySG with the cloud proxy and perform NTLM identification:

1. Follow the stepsin Basic chaining, page 28.
2. Logon tothe Cloud Security portal.

3. Select Web Security > Policy Management > Policies > policy name > Access
Control, then click Edit.

4. Select Always authenticate userson first access, then select NTLM
transparent identification where possible. For more information, see NTLM
identification in the Cloud Security Help.

5. Click Submit.
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X-Authenticated-User chaining

You can pass authentication details from your Blue Coat proxy to send
X-Forwarded-For and X-Authenticated-User headers to the cloud proxy either by
manually editing a policy text file, or defining the policy in Blue Coat Visua Policy
Manager.

X-Forwarded-For Contains the client | P address

X-Authenticated-User When Blue Coat authentication is turned on, this
header will be populated with the user domain and
username (domain\user).

With this setup, end users can be authenticated transparently by the cloud proxy,
removing an authentication step and improving performance.

Note that for Blue Coat to service HTTPS requests properly with the following setup,
you must have a Blue Coat SSL license and hardware card.

Editing the local policy file

In the Blue Coat Management Console Configuration tab, click Policy in the left
column and select Policy Files. Enter the following code in the current policy text file,
using an Install Policy option:

<Proxy>
action.Add [header name for authenticated user] (yes)

define action ddl[header name for authenticated user]
set (request.x_header.X-Authenticated-User, "WinNT://
$ (user.domain) /$ (user.name) ")

end action Add[header name for authenticated user]

action.Add [header name for client IP] (yes)

define action dd[header name for client IP]
set (request.x header.X-Forwarded-For, $ (x-client-address))
end action Add[header name for client IP]

Using the Blue Coat graphical Visual Policy Manager

Before you configure the Blue Coat header policy, ensurethat NTLM authentication is
specified in the Blue Coat Visual Policy Manager (Authentication > Windows SSO).
Set Websense Cloud Web Security as the forwarding host (in the Blue Coat
Management Console Configuration tab, Forwarding > Forwar ding Hosts). The
address of the Cloud Web Security service iswebdefence.global .blackspider.com, port
8081.

In the Blue Coat Management Console Configuration tab, click Policy and select
Visual Policy Manager. Click Launch and configure the header policy as follows:

1. InthePolicy menu, select Add Web Access Layer and enter an appropriate
policy namein the Add New Layer dialog box.

2. Select the Web Access L ayer tab that is created.
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9.

10.
11.

12.
13.

14.
15.
16.

17.

18.

The Source, Destination, Service, and Time column entries should be Any (the
default).

Right-click the areain the Action column, and select Set.

Click New in the Set Action Object dialog box and select Control Request
Header from the menu.

In the Add Control Request Header Object dialog box, enter a name for the client
IP Action abject in the Name entry field.

Enter X-Forwar ded-For in the Header Name entry field.
Select the Set value radio button and enter the following value:
S (x-client-address)

Click OK.

Click New and select Control Request Header again.

In the Add Control Request Header Object dialog box, enter a name for the
authenticated user information Action object in the Name entry field.

Enter X-Authenticated-User in the Header Name entry field.

Select the Set value radio button and enter the following value:
WinNT://$ (user.domain) /$ (user.name)

Click OK.

Click New and select Combined Action Object from the menu.

In the Add Combined Action Object dialog box, enter a name for a proxy chain
header in the Name entry field.

In the left pane, select the previously created control request headers and click
Add.

Select the combined action item in the Set Action Object dialog box and click
OK.

Click Install Policy in the Blue Coat Visual Policy Manager.

Squid Proxy

Cloud Web Security supports the configuration of a chained Squid open source
downstream proxy, in the following cases:

L 4

L 4

Basic chaining
For policieswhere NTLM is enabled and end users are asked to authenticate for
Cloud Web Security

The Squid proxy must be version 3.1.5 or later.

Basic chaining

In this case, Squid forwards requests to the cloud proxy but performs no
authentication. End users can be authenticated using manual authentication only:
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prompting users for a user name and password the first time they access the Internet
through a browser.

Configure Squid to forward requests to the cloud proxy as follows:

1. Define one or more ACLsto identify sites that should be not be filtered through
Cloud Web Security. These must include certain service-specific sites, and should
include any other sites that are not normally handled through the cloud service.
You can identify these sites by examining the service-generated PAC file available
at http://webdefence.global .blackspider.com:8082/proxy.pac.

You should also configure direct access to the Cloud Security portal to allow the
following:

m  Correct display of block pages
s End-user self-registration

If you are using the roaming user home page (http://
home.webdefence.global .blackspider.com/), that should also be configured as an
ACL.

Thefollowing sites must be included in the ACLSs:

acl WBSN dstdomain .mailcontrol.com

acl WBSN dstdomain www.blackspider.com

acl WBSN dstdomain webdefence.global.blackspider.com
always_direct allow WBSN

2. Forceall other sitesto use the cloud proxy asfollows:
never direct allow all
3. Tdl Squid the location of the upstream cloud proxy:

cache peer webdefence.global.blackspider.com parent 8081 0
no-query default no-digest

NTLM chaining

The Squid proxy performslocal NTLM identification, then forwards the appropriate
Proxy-Authorization headers asan NTLM Type 3 message to the cloud proxy for
further transparent user authentication. Squid can maintain multiple connectionsto the
cloud proxy, allowing the sharing of connections across users but ensuring that each
reguest is associated with the correct user. When Squid reassigns a connection to
another user, only then is a new Proxy-Authorization header sent for that user.

To use this setup, configure Squid to do the following:
1. Perform NTLM authentication.

2. Forward requests to the cloud proxy.
3. Forward user information to the cloud proxy.
Configuring Squid for NTLM authentication

To configure Squid to perform NTLM authentication of users, refer to the Squid
documentation:
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http://wiki.squid-cache.org/ConfigExampl es/A uthenticate/Ntlm

Forwarding requests to the cloud proxy

To configure Squid to forward requests to the cloud proxy:

1. Define one or more ACLsto identify sites that should be not be filtered through
Cloud Web Security. These must include certain service-specific sites, and should
include any other sites that are not normally handled through the cloud service.
You can identify these sites by examining the service-generated PAC file available
at http://webdefence.global .blackspider.com:8082/proxy.pac.

Thefollowing sites must be included in the ACLSs:

acl WBSN dstdomain .mailcontrol.com
acl WBSN dstdomain www.blackspider.com
acl WBSN dstdomain webdefence.global.blackspider.com
always_direct allow WBSN
2. Forceall other sitesto use the cloud proxy asfollows:
never direct allow all
3. Tdl Squid the location of the upstream cloud proxy:

cache peer webdefence.global.blackspider.com parent 8081 0
no-query default no-digest

Forwarding user information to the cloud proxy

To configure squid to forward user information, add option login=PASS to the cache-
peer line:

cache peer webdefence.global.blackspider.com parent 8081 0
no-query default no-digest login=PASS
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When a Cloud Web Security proxy receives arequest, itsfirst task isto identify the
correct policy to use. First, it checks the | P address that is the source of the request.
Typically, thisis the external |P address of your firewall. If this |P address matches a
proxied connections setting in apolicy, then that policy isused. Otherwise, the user is
invited to log onto the Cloud Web Security service (by an email addressthat is used as
aunigque logon name), and the user’s email addressis used to find the correct policy.

Initial settings

In the Cloud Security portal, under Web Security, thereisasingle policy caled
DEFAULT. Initialy, thispolicy has no proxied connections. It is possibleto use Cloud
Web Security like this, but it may be inconvenient because users always have to
authenticate and you have to manually invite each user to register on the service.

Policy selection by IP address

There are two reasons for allowing policy selection by |P address:

1 Toallow usersto use the service anonymously - they don't have to authenticate.

2. To provide different policies for parts of your organization, each being
distinguished by different |P addresses. Thisistypically used by remote offices
with their own Internet gateway and can be used, for example, to delegate user
administration and reporting to local support personnel.
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The Cloud Web Security service works “out of the box” for many organizations. A
single policy applied to an organization’s Web traffic provides protection from
malware and inappropriate content. Maost companies, however, want to tailor the
serviceto align it with their Internet usage policy, which may require granular
configuration on a per-user and per-group basis. Also companies usually want to
report on the surfing habits of their employees, which requires users to identify
themselves.

Cloud Web Security offers a number of options for user identification and
authentication:

+ Instaling Web Endpoint on end users' machines ensures that those users are both
authenticated and always filtered by Cloud Web Security. See Setting up Web
Endpoint, page 37.

+ Websense Authentication Service can be installed on your network to provide
clientless, seamless authentication. See Setting up Authentication Service, page
46.

+ You can register your end users with Cloud Web Security to enable NTLM
identification, secure form-based authentication, or manual authentication.
Alternatively, you can request users to self-register, or identify themselves for
NTLM. See End-user registration, page 47.

Authentication and identification options are set up on the Access Control tab within a
policy, meaning that you can specify different authentication methodsfor different end
users.

Setting up Web Endpoint

Websense Web Endpoint is a piece of software that getsinstalled on an end user’s
machine. It enforces the use of Hosted Web Security for Web filtering, and passes
authentication information to the cloud proxies, enabling secure transparent
authentication.

The endpoint appends two additional headersinto each HTTP request. One header
tells Cloud Web Security which version of the endpoint is installed; the other isan
encrypted token which identifies the end user. This enables Cloud Web Security to
apply the appropriate policy for that user and correctly log reporting data. These
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headers do not include any domain passwords or other security information, meaning
that there is no security risk in using the endpoint. The headers are then stripped from
the requests by the Cloud Web Security proxy.

The endpoint has a number of key protections against tampering, which should
prevent the majority of end users uninstalling or deleting the endpoint even if they
have local administrator rights:

Windows and M ac operating systems

+ Endpoint files and folders are protected from deletion and cannot be modified,
moved, or renamed.
¢ Theendpoint process will automatically restart if it is stopped or killed.

+ A password isrequired to uninstall the endpoint or stop the endpoint service.
Windows oper ating systems only

+ Endpoint registry settings cannot be modified or deleted.
¢ The Service Control command to delete the endpoint service is blocked.

Note

Endpoint for the Mac may not currently be enabled for all
Cloud Web Security customers.

Endpoint system requirements

Windows operating systems
Web Endpoint is supported on the following 32-bit and 64-bit operating systems:

+ Windows XP with Service Pack 2 or higher

+ Windows Vistawith Service Pack 1 or higher

¢ Windows7

The following Web browsers fully support Web endpoint for Windows operating
system users.

+ Internet Explorer 6 or higher

& Firefox 3.x, 4.x, 5, or higher

The endpoint can be installed either by GPO or directly from the cloud service. Once
installed on these browsers, the endpoint provides user authentication, enforces
filtering via Cloud Web Security, and is able to manipulate proxy settingsin real time
—for example, to temporarily disable itself at public Internet access pointsto alow a

roaming user to complete the billing requirements. Updates directly from the cloud
service are also supported.

If your end users have browsers other than those listed above, you can download the
endpoint installer and deploy it to those users. Once installed, the endpoint provides
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user authentication and enforces filtering via Cloud Web Security, but cannot perform
proxy manipulation and cannot be updated directly from the cloud service.

The Windows installer isless then 5MB in size, and requires less than 10MB in hard
disk space and less than 6MB in memory usage.

Full support means that the browser supports al installation methods, and both Web
scanning and filtering and proxy manipulation.

M ac oper ating systems

Web Endpoint is supported on the following 32-bit and 64-bit operating systems:
¢ Mac OSX v10.6 or 10.7

The following Web browsers fully support Web endpoint on the Mac:

o Safari 5.1 or higher
o Firefox 8.0 or higher
+ Google Chrome 15 or higher

If your end users have browsers other than those listed above, you can download the
endpoint installer and deploy it to those users. Once installed, the endpoint provides
user authentication and enforces filtering via Cloud Web Security. Proxy manipulation
iS supported.

For Mac end users, no option exists to auto-update the endpoint. You must uninstall
the endpoint first.

Theinstaller for the Mac islessthan 2MB in size and requires lessthan 10MB in hard
disk space.

Downloading and distributing the endpoint

Download the latest version of the endpoint from the Web Security > Settings >
Endpoint Download page in the Cloud Security portal. If you are using a Windows
operating system, the endpoint is available in separate installation packages for 32-bit
and 64-bit operating systems.

The endpoint for the Mac consists of only one installation package for both 32-bit and
64-bit operating systems. Note that you do not need to reinstall Web Endpoint for the
Mac if you switch between these systems.

Before you can download the installation file or enable deployment from the cloud
service, you must define an anti-tampering password to be used to stop the endpoint
service or uninstall the endpoint. The password is automatically linked to any
deployments of the endpoint, including Web deployments. To set the password, do the
following:

1. Under Set Anti-Tampering Password, click Set Password.
2. Enter and confirm your anti-tampering password, then click Submit.
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Important

For security reasons, Cloud Web Security does not retain a
copy of your anti-tampering password. If you forget your
password, you can reset it in the portal by entering and
confirming anew password. All installed endpointswill be
updated to use the new password next time they connect to
the Internet.

o=@

Windows operating system users should note the script command displayed on screen
and use it to configure your GPO deployment script or manual installation. This
command is in the format:

WSCONTEXT=XXXX
where xxxx is a unique code for your account.

The command is required during installation to associate the endpoint with your
customer account and enable your end users to log on transparently.

For Windows operating system users

Distributing the endpoint via GPO

Follow the steps below to deploy endpoint clients through an Active Directory group
policy object (GPO):

1. Unzip the downloaded endpoint file to alocation of your choice.

2. Create ashared folder (create afolder and turn on sharing in the Properties menu).

3. Create abatch file (.bat) in the shared folder, for example “installmsi.bat”. This
can be done in any text editor.

Type the following msiexec command into the batch file and save it.

msiexec /package "\\path\Websense Endpoint.msi" /quiet /
norestart WSCONTEXT=xXXXX

Where:
m  path isthe path to the unzipped installer

m  WSCONTEXT=xxxx iSthe script command noted from the Endpoint Download
screen in the portal

4. Test your batch file manually to make sure it runs on other workstations. You can
do this by opening the server path to the file on aworkstation and attempting to
run the file. If the file does not run, check your permissions.

5. Open the Group Policy Management Console (GPMC).

6. Create anew (or open an existing) GPO on the organization unit (OU) in which
your computer accounts reside. To create a new GPO:

a. Inthe consoletree, right-click Group Policy Objectsin the forest and
domain in which you want to create a Group Policy object (GPO).
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10.
11.
12.

b. Click New.

c. Inthe New GPO diaog box, specify a name for the new GPO, and the click
OK.

Open Computer Configuration > Windows Settings > Scripts, and double-
click Startup in the right pane of the screen.

Click Add.

In the Script Name field type the full network path and filename of the script
batch file you created in step 2.

Click OK.
Close the GPMC.

Run the gpupdate /for ce command at the command prompt to refresh the group
policy.

The application should be installed on startup. The client may not be fully functional
until areboot occurs.

Installing the endpoint on a single machine

Follow the steps below to deploy an endpoint client on a single machine. Note that
you must have administrator rights on the machine.

1
2.

3.

Unzip the downloaded endpoint file to alocation on the machine.

Open a command-line window, and navigate to the location of the unzipped
endpoint files.

Enter the following command:

msiexec /package "Websense Endpoint.msi" /norestart
WSCONTEXT=XXXX

Where WSCONTEXT=xxxx iS the script command noted from the Endpoint
Download screen in the portal

To confirm the endpoint isinstalled and running, go to Sart > Control Panel >
Administrative Tools> Services. Check that “Websense SaaS Service” is present
in the Serviceslist, and is started.

For Mac operating system users

To deploy Web Endpoint manually on a single machine, follow these steps:

1

2.

Under Mac Endpoint Client, click on the version number to download the
endpoint zip file.

When you download the endpoint, it should include the endpoint.pkg file along
with afile called HWSConfig.xml, which is specific to your account. Thisfile
needs to be in the same directory as the .pkg file for the endpoint to successfully
install.

Note that if you wish to use the endpoint over port 80 for proxying and PAC file
retrieval, you need to do the following before installing the endpoint:
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= Ask your endpoint support representative to add the “ Send HWS endpoint to
port 80" template to your account. You can add this template to specific
policies or globally.

= Change the HWSconfig line from the following:

<PACFile URL="http://webdefence.global .blackspi der.com:8082/proxy.pac” />
To this:

<PACFile URL="http://pac.webdefence.global .blackspider.com/proxy.pac” />

By applying this template, you will also move to port 80 any endpoints that are
aready installed.

3. Double-clicking the endpoint package brings you to an introductory screen for the
installer. Click Continue for step-by-step instructions on the installation process.

4. Your will arrive at the “ Standard install on “Macintosh HD” screen.”

5. Click Install to begin the installation process. Note that you must install the
endpoint on the local hard disk. You can also change the installation location on
this screen as well by clicking Change Install L ocation ...

6. Enter auser name and password for a user with administrator rights to install the
software.

If the installation process fails, check that the HWSconfig.xml fileis present and
isin the correct format if you have edited it.

7. A confirmation screen informsyou if theinstallation is successful. Click Close.

8. After installation, go to System Preferences> Other. Click theicon for the
endpoint program.

9. Thisbringsyou to a page where you can see available components for the version
you have installed. You can also do the following:

m  Save Debug L ogsto Desktop
= Uninstall Endpoint.

Save Debug L ogsto Desktop allows your endpoint support team to quickly
access all troubleshooting logsin one place. Clicking it creates an archive file on
the Mac desktop beginning with ClientInfo*.zip. If you need to open a support
ticket about the endpoint, include this zip file with your request.

Identifying Mac end users of endpoint

When aMac user islogged into an active directory-based domain, Web Endpoint
identifies users in the same way that it does for Windows operating system users. For
Mac users not logged into a domain, however, the endpoint formats the user detailsin
as mac.local.[local_username].

For example, if you are logged in as “ Joe Bloggs,” it would appear as
mac.local .joebloggs.

To search for al locally logged-on Mac users, do the following:

1. GotoWeb Security > Account Settings> End Users.
2. Inthe Namefigld, enter “mac.local*”
3. Click Search.
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Thisbringsup alist of al Mac users that are logged on locally.

Changing the policy of a Mac end user
To change the policy of a Mac user, do the following:

1. After searching for all locally logged-on users (see |dentifying Mac end users of
endpoint, page 42), in the Please select an action ... drop-down menu, select
Change Web palicy.

2. Choose the policy that you want to move the selected Mac user to.
3. Select each of the displayed Mac users you want to move and click the Go button.
The new policy is applied to these users.

Note that two Mac usernames will be common across al of your Mac users:
mac.local.root and mac.local._softwareupdate. These users receive software
updates from the internet. It is best practice to limit access by these usersto just a
few categories, such as Information Technology.

Uninstalling endpoint from the Mac
You can uninstall the endpoint by doing the following:

1. Goto System Preferences> Other, and click the icon for the endpoint software.
2. Click Uninstall Endpoint.

3. Enter theloca administrator name and password.

4

Click OK. Then enter the endpoint anti-tampering password that you set in the
Cloud Security portal.

Click OK to begin uninstalling the endpoint.

o U

You will receive a confirmation message if the endpoint was successfully
uninstalled

7. Click OK to finish the process.
You can aso uninstall the endpoint through the command line:

1. After entering the Mac administrator password, run this command:
sudo wepsvc --uninstall
2. You will be asked for the service password, which is the default password unless
the password was changed in the Cloud Security portal.
To stop the endpoint, do the following through the command line:

1. After entering the Mac administrator password, run this command:
sudo wepsvc --stop

2. You will be asked for the service password, which is the default password unless
the password was changed in the Cloud Security portal.
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Deploying the endpoint from the cloud service

You can deploy the endpoint on a per-policy basis to either the roaming users or all
usersin apolicy directly from the cloud service.

When you select this option, on the Endpoint tab of a policy in the Cloud Security
portal, end users are prompted to install the endpoint next time they open a browser.
See Local users, page 44, and Roaming users, page 45. You can customize the text on
thefirst page of the installer to make it clear that the installation is sanctioned by your
organization.

The endpoint installer for Windows operating system usersis available in English,
French, German, Italian, Spanish, Dutch, Simplified Chinese, and Japanese. The
language used for the installation is picked up from the browser settings.

Local users

For Windows operating system users, when the endpoint has been deployed to all
usersin apolicy, an end user opening Internet Explorer or Firefox sees the following:

. h Secure Browsing Installation Recommended

Inc. has chosen to enable secure browsing for its employess.

* This feature protects you from intemnet threats.

& To enable this feature you need to mnstall an application.

® I[fyou choose not to install, vou need to frequently re-enter your email and password to
access the mternet,

Install Secure Browsing [ Ask me next time

If the user clicks Install Secure Browsing, they are redirected to an assistance page
that explains the installation process for their browser. They then click Continuewith
theinstallation to install the endpaint.

If the user clicks Ask me next time, Cloud Web Security falls back to alternative
authentication or identification methods if enforced in the Access Control tab for the
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user’s policy. The endpoint installer will reappear next time the user opens a Web
browser.

Note

‘/ If you do not wish your end usersto be able to opt out of
endpoint installation, you can edit the Endpoint opt-out
notification page in the Cloud Security portal to remove
the Ask me next time button. For more information, see
“Notification pages’ in the Cloud Web Security
Administrator’s Guide.

Roaming users

For Windows operating system users, when the endpoint is deployed to roaming users,
the user must first authenticate using their basic authentication credentials, if they
have them. If they do not already have credentials, they must self-register with Cloud
Web Security (see End-user self registration, page 48).

Oncethey are registered and have logged in using basic authentication, the endpoint
installer starts and the processisthe same asfor local users. If the user clicks Ask me
next time, the user is presented with amanual authentication login page each time
they access the Internet as aroaming user, followed by the endpoint installation page.

Updating the endpoint

For Windows operating system users, the Endpoint tab in Web policiesincludes an
auto-update feature which can automatically deploy newer versions, without desktop
administrators getting involved. If you select this option, it appliesto all usersin the
policy who have installed the endpoint, regardless of whether it has been deployed via
GPO or directly from the policy, assuming their browser supports deployment from
the cloud service.

Mark Automatically update installations when a new version isreleased on the
Endpoint tab if you want to ensure that endpoints on your client machines have the
latest version when it is available.

The setting is disabled by default, as most organizations like to control the software on
the desktop themselves and test newer versions before deploying them. You may want
to enable the option once you have tested the new software so all users (including
roaming users) get the latest endpoint installed. Once they have all updated the
endpoint, you can then disable updates again.

Note that while an endpoint update is taking place (which can take several minutes),
end users will be unable to browse, but will be shown a Web page stating that the
endpoint isupdating. This page will continueto retry the requested Web page every 10
seconds until the endpoint has finished updating, and will then display the requested
page correctly if the user is allowed to access this URL, or alternatively will display a
block page.
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Setting up Authentication Service

Websense Authentication Service is an on-network virtual machine that provides an
interface between the Cloud Web Security proxy server and the Microsoft Active
Directory or LDAP services used on-premises at your location. All communications
between components are secured.

Authentication Service requires installation and configuration on a machine in your
network, and setup in the Cloud Security portal. For more information, see the
Authentication Service Installation and Configuration Guide.

Local users

The end user authenticates with the Active Directory/L DAP server within the
network, leveraging existing network security. When a user from within the corporate
network accesses an external URL, they are redirected to Authentication Service,
which authenticates the user with your LDAP directory and generates a SAML
assertion to the Cloud Web Security proxy. The user isthen directed back to the proxy
and the appropriate policy is applied.

if- | Websense hosted/hybrid
N J proxy
SAML 2.0

Authentication Semvice @ ;
\‘ f i
LDAP/35L !

During this process, the end user may briefly see an information page stating that they
are being redirected for authentication.

All user authentications happen in-network, although users can also authenticate from
outside the network viaa VPN connection.
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Users who have authenticated once do not then have to re-authenticate for subsequent
Web browsing sessions, for aperiod of time defined by the Session Timeout option in
the Cloud Security portal.

If either Authentication Service or your directory server are unavailable at the time of
the authentication request, end users are authenticated based on the selected options
on their policy’s Access Control tab.

Roaming users

When aroaming user accesses the Cloud Web Security proxy from outside their LAN,
the user’s domain credentials are requested by the cloud proxy and passed to
Authentication Service to be validated against your Active Directory/LDAP server.
Oncethese credential s are verified with Authentication Service, the appropriate policy
isapplied for that user. The roaming user does not have to re-authenticate from this IP
address until the session times out, as defined by the Session Timeout option in the
Cloud Security portal.

Websense hosted/hybrid
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Enterprise netwaork

If either Authentication Service or your directory server are unavailable at the time of
the authenti cation request, the roaming user is presented with either asecureform or a
a basic authentication login page, depending on the options selected on the Access
Control tab, with alink that enables the user to self-register if required.

End-user registration

If you do not deploy Web Endpoint or Authentication Service, the following options
are available for end-user registration, and subsequent authentication or identification:
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Directory synchronization
End-user self registration

* & o

Bulk registering end-users
¢ NTLM transparent identification registration

These options are also used as afallback if either the endpoint or Authentication
Servicefails.

Directory synchronization

Cloud Web Security includes a directory synchronization feature for organizations
with an LDAP-compliant directory (such as Active Directory). If you have adirectory
like this and you use the synchronization feature, you do not need to register end
users. When you synchronize your directory with the cloud service, users are
automatically registered.

If directory synchronization includes NTLM IDs, you can enable NTLM
identification on the Access Control tab; then your users can use the service
immediately after synchronization. Thisisthe easiest way to get users going with the
service.

If you enable NTLM identification but for some reason do not synchronize NTLM
IDs from your directory, your users are required to self-register and then associate
their NTLM IDs with their user accounts on the service.

If you don’t want to use NTLM identification, you can configure the service to send
invitations to all newly synchronized users. They can then complete the self-
registration process and log in using email address (or name) and password.

Through the directory synchronization feature, you have the option to notify new
users that they are protected by the cloud service when they surf the Web.

End-user self registration

The second easiest way to register usersisto invite them to self-register. For those
using secure form-based or basic authentication, there are 3 steps for individual end-
user self registration:

1 You enter your email domains into the policy or account.
2. Userscomplete stage 1 registration (enter name and email addressinto aform).
3. Userscomplete stage 2 registration (create a password).

Users can access the stage 1 registration form at:

https://www.mail control.com/enduser/reg/index.mhtml

or by clicking Register on the default pre-login welcome page or NTLM registration
page that is presented when they are forced to identify or authenticate themselves.

Once users have entered their name and email address into the form, they receive an
email from Websense Cloud Web Security. This contains alink, that when clicked,
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takes them to a page where they can complete registration stage 2 by creating a
password.

Bulk registering end-users

Bulk end-user registration simplifies the self-registration process by reducing it from
2 stepsto 1. Rather than end users visiting the portal and entering their name and
email addressinto aform, you upload all their names and addresses at once. End
users automatically receive email notification once the bulk upload is finished. They
can then click alink on the email they receive and create a password on the portal.

NTLM transparent identification registration

If you do not have an LDAP directory and your users are using NTLM transparent
identification, an additional one-time step is required.

Thefirst time these users send arequest to Cloud Web Security, an NTLM registration
form appears where they must enter their email address and password. Cloud Web
Security associates these user credentials with the NTLM credential s automatically
obtained from the browser. This assaociation is saved and the user does not haveto
complete this step again.

v

Note

If you are using directory synchronization and have synchronized NTLM IDs, users
are not prompted for thisinformation. Only NTLM users who self-registered, were
invited to register, or were bulk registered have to perform this step.

End-user authentication

End users can use the details entered during registration to authenticate with Cloud
Web Security when working remotely or, if forced authentication is configured within
the policy, whenever they access the Internet.

For secure form-based authentication, users are asked to authenticate the first time
they open a browser. Users who have authenticated once do not then have to re-
authenticate for subsequent Web browsing sessions, for a period of time defined by
the Session Timeout option on the Access Control tab.

For basic authentication, users are asked to authenticate when opening a new browser
instance. Once authenticated, they are not asked to authenticate again aslong as the
browser remains open.

Warning

If you want to protect remote users, instruct them to log onto the service using their
email address and the password with which they registered. NTLM transparent
identification is not used when the browser has connected from a remote location.
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End-user identification

If the policy dictatesthat NTLM isto be used to identify users unlessthey are working
remotely, end users never have to login, but their surfing habits can be monitored and
per-user configuration can be applied. In this case, the users are transparently
identified.

Authentication priority and overrides

You can select multiple authentication options for your end users on the Access
Control tab of apolicy. The options are prioritized as follows:

Web Endpoint is always used if installed on an end user’s machine.

If Web Endpoint is not installed or fails, Authentication Serviceis used if:

= it has been deployed in your network, and

= it has been selected on the Access Control tab for the end user’s palicy.

+ If neither Web Endpoint nor Authentication Service is available, the end user is
authenticated via secure form-based authentication, if:

= it has been salected on the Access Control tab, and

m theuser agent or application requesting authentication supports form-based
authentication viaan HTML page.

+ Applicationsthat do not support form-based authentication use either NTLM
identification or basic authentication. Basic authentication is always used if you
have chosen to enforce end-user authentication and none of the other options are
either selected or available.

You can also enforce a specific authentication option for certain end users, overriding
the authentication settingsin the policy, by deploying aPAC file URL in the following
format:

http://webdefence.global .blackspider.com:8082/proxy.pac?a=X
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The a= parameter controls the authentication option, and X can be one of the

following:

Parameter

a=n

Description

NTLM identification or basic authentication is used,
depending on the policy settings and the browser or
application capability.

at

Authentication is performed using Authentication
Service.

If the application or user agent cannot use
Authentication Service, NTLM identification or basic
authentication is used.

If aremote user cannot log on to Authentication Service,

they are given the option to try again or log on using
Websense credentials.

a=f

Authentication is performed using secure form-based
authentication.

We recommend that you deploy PAC files with the a= parameter if you want some of
your usersin a policy to use Authentication Service, and othersto use secure form-
based authentication. This is because the two methods use different ports on the cloud
service (see Configuring Your Firewall, page 11).
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Working with Remote
Users

Cloud Web Security can protect and monitor users even when they are not in their
normal office location, such as when they are travelling. This section describes how
Cloud Web Security handles users who are roaming from their network domains.

Cloud Web Security works on the basis of source IP. When the service receives a
reguest, for example www.google.com, Cloud Web Security checks the source IP
address of the requests and searches all the customer policiesto find the policy with
that source | P address. The source | P address is configured as a proxied connection on
apolicy’s Connectionstab in the Cloud Security portal.

If users are roaming, they are most likely either at home, an Internet cafe, a hotel, or
an airport. It isunlikely that the IP addresses of these places are configured in any of
your proxied connections. In this situation, the roaming user encounters one of the
following scenarios:

+ |f the user has alaptop with Web Endpoint installed, the endpoint forces a
connection to Cloud Web Security to send authentication and get the PAC file and
policy settings appropriate for the user.

+ If you have deployed Websense Authentication Service, the roaming user must
enter their email address and network password whenever they connect to the
cloud proxy. These credentials are verified with Authentication Service and the
appropriate policy is applied for that session.

+ If neither Web Endpoint nor Authentication Service isin use and the service
cannot find the source | P addressin any of the customer poalicies, then Cloud Web
Security responds with alogon page stating, “ You are connecting from an
unrecoghized location.” The user hasto log on. When they do, Cloud Web
Security searches for them in the policies. When it finds the user, the service
knows who they are, which policy they are using, and how to filter the request (in
other words, whether to allow or block the request).

In order to log on, the user hasto be registered. Roaming users must go through
the one-time registration process to be covered.

Some browsers exhibit inconsistent behavior in certain circumstances, such aswhen
used in public Internet access pointsin hotelsand airports. If the browser is configured
to get the PAC file from the Cloud Web Security service, it is possible that it may not
be able to immediately do so. In such situations, some browsers fall back to direct
connections bypassing Cloud Web Security. This can occur in the following
situations:
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1. The Web browser islaunched and the laptop does not have Internet access
because it does not have | P connectivity, nor isit connected to another device,
such as arouter, with I[P connectivity. The browser cannot get the PAC file from
the Cloud Web Security service. Thistypically occursin home office
environments.

2. Thelaptop has full network connectivity but is unable to connect to the Internet
becauseit islocated behind afirewall that is preventing this. Thistypically occurs
when the user is connected to a third-party’s network — either corporate or public.

These scenarios are expanded upon below.

How to determine whether a browser is using
Cloud Web Security

Websense offers atool to help identify whether abrowser has a proxied connection to
Cloud Web Security. You can run the tool by clicking the Proxy query pagelink on
the Web Security > Settings > Configuration info page.

The returned page looks like this if you are using the Cloud Web Security proxy:

Hosted Web Security Confirmation Page

/ Yes you are using the Hosted Web Security Filtering Proxy Server

If you are not using the Cloud Web Security proxy, it looks like this:

Hosted Web Security Confirmation Page

x Mo you are not Using the Hosted Weh Security Filtering Proxy Senver

This proxy query page link has also been embedded in the Cloud Web Security remote
user home page: http://home.webdefence.qglobal .blackspider.com/. Thishome pageis
also used to help resolve other challenges associated with remote user connectivity.
Websense recommends making this the home page for all remote users.

You can customize the remote user home page if required. The URL for the resulting
account-specific pageis available from your account in the Cloud Security portal. It
looks like the figure above, but has an account-specific identifier appended to it.
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Connecting from home

In some circumstances, home users might connect to a network, launch a browser, and
find that they are not using Cloud Web Security.

This can happen for two main reasons:

+ The user launches the browser before the computer receivesits IP configuration
information.

+ The computer connects to a network that uses a router that does not have an IP
address assigned. This can occur with some Internet connections that use
dynamically assigned | P addresses such as some home broadband connections. If
the connection hasn’t been used for sometime, the router’s lease for its |P address
may have expired.

In both of the above cases, the browser tries to get the PAC file and fails. If the
computer then getsits |P addressimmediately after the failure to get the PAC file, the
browser then accesses the Internet directly without retrying the PAC file.

Solutions

Deploy Web Endpoint

Installing the endpoint, either for roaming users or all users, ensures all Web trafficis
routed via Cloud Web Security. In the above scenario, Internet access will be denied
until the endpoint can access Cloud Web Security to send user authentication and get
the PAC file and policy settings appropriate for the user.

For more information, see Setting up Web Endpoint, page 37.

The benefit of thisisthat use of Cloud Web Security is enforced regardless of delays
with network connectivity. The drawback is that Web Endpoint is only available for
Windows operating systems.

Use a local copy of the PAC file

Download a copy of the PAC file, saveit locally, and configure the browsersto use it.
Thisensuresthat the browsers can always accessit regardless of network connectivity.

The benefits of this solution are that the users’ browsers are always able to access the
PAC file regardless of any delay in the laptop receiving IP configuration, and no user
intervention is required. The disadvantage is that you must download the PAC file to
the laptop every time an unproxied destination is added to your Cloud Web Security
policy. Itisunlikely for thisto occur often and you can automate distribution of the
PACfile.
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Connecting from third-party corporate networks

When connecting from athird-party corporate network, users most likely are behind a
firewall that may restrict Internet connectivity.

Why this may occur:

+ Thelaptop is connected to a network behind afirewall that does not allow
connectivity using port 8082, and the browser is unable to get the standard PAC
file from Cloud Web Security.

+ Thelaptop is connected to a network behind afirewall that does not allow
connectivity using port 8081, and the browser is not able to communicate with the
proxy.

Solution

Use the PAC file available via port 80

If port 8082 islocked down, a URL is available that enables the remote user to access
the PAC file and cloud service over port 80. Remote users should also usethe PACfile
address for port 80 if requesting access from a network that has port 8081 locked
down. Even if they can access the PAC file on port 8082, port 8081 is the standard
required port to be able to use Cloud Web Security filtering.

This URL is available on the Web Security > Configuration info page, and a policy-
specific version is displayed on the General tab of each policy.

Use the security solution on the corporate network

If port 8081 islocked down, it islikely that in this scenario, the organization to whose
network the laptop is connected has its own security policy in place and wishes the
user to be governed by it, requiring reconfiguration of the laptop. Alternatively some
organizations have “ public networks’ that they provide visitors.
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1 O Tailoring Your Policy to
Meet Your Needs

You should now be directing all Internet traffic through the Cloud Web Security
service and are protected from Internet threats. Cloud Web Security works “out of the
box,” but to get best use of its features, you probably want to tailor your policy.
Specific areas of interest may be:

Creating additional administrators to delegate responsibilities

Setting the time zone for your policies

Customizing your notification pages

Adding internal or other trusted sites to your non-proxied destinations

Adjusting the Web site category dispositions to suit the nature of your business

Creating custom categories to alow whitelisting or blacklisting of specific Web
sites

* 6 6 o o o

Creating groups of users
Creating exceptions to override category dispositions for specified users, groups,
and times of day

Configuration advice for all of these features and others can be found in the Cloud
Web Security Administrator’s Guide. Download this guide from the Support area of
the Cloud Security portal.
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1 1 Recommendations for an
Evaluation

Some of the major benefits of Cloud Web Security over competing solutions are that:

As an on-demand service, it lends itself to small scale evaluation.

It allows rapid expansion of the numbers of usersinvolved at the proof-of-concept
stage.

+ It alowsrapid deployment into production after successful completion of the
evaluation.

During theinitial stages of an evaluation, we recommend that you manually configure
a number of Web browsers to access the Cloud Web Security PAC file. Once you are
happy that the service works as expected, you can add more users, perhaps by using
Active Directory group policy to configure browsers. Alternatively, if you have an
existing proxy, you may be able to proxy chain for a subset of users before deploying
across the compl ete organi zation.

You can also deploy Web Endpoint for a small number of users to test enforcement
and seaml ess authentication.
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Preparing Your End Users
for Deployment

Before deploying Cloud Web Security, you should inform your users what the service
does and how it impacts them. This may even be alegal requirement in some
countries. Below is some sample text that you can use in an initial communication.
You can also customize the registration email templates and pre-login welcome page,
if you are going to use them.

Note that text initalicsisinstructional and not meant for inclusion in any
communication.

Introduction to the Websense® TRITON™ Cloud Web Security service

Cloud Web Security is aWeb security service that we have deployed to protect
Internet users from computer viruses and other Web-based threats such as spyware.
All of our Internet traffic is directed to Websense's data centers where these threats are
filtered out and our Internet acceptable use policy is enforced.

Many Web sites exist that contain viruses or inappropriate content that might offend
you. Often links to these sites are returned by search engines and you do not realize
what you are accessing until you have clicked alink and it is too late. The Websense
Cloud Web Security service allows us to block such sites so that you are not exposed
to this content.

Internet acceptable use policy

We have published an Internet acceptable use policy that outlines your responsibilities
as an individual when using company resources to access the Internet. Websense
Cloud Web Security allows usto enforce this policy, report on Web usage and block
inappropriate downloads. In the event that a Web site is blocked, you are presented
with a Web page explaining why.

We recognize that different people need to access different types of Web sitesto
perform their jobs, so if sites that you are trying to access are being blocked, please
email XX XX, include the Web site address and the reason why you need to accessit.
The full Web site address can be copied from your browser address bar.

Please click the link below to access our corporate Internet acceptable use policy.

http://link_to_corporate acceptable use policy
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Web Endpoint

Deploying Web Endpoint via the Web

To use the Cloud Web Security service, you will be asked to install a Secure Browsing
application next time you open a browser. Follow the instructionsin the installer. This
application ensures your browsing is always protected by Cloud Web Security,
whether inside or outside the office.

End-user registration

Registering to use Cloud Web Security

To use the Cloud Web Security service, you first need to complete asimple, one-time
registration process.

If not using bulk registration

+ Click thelink below. It takes you to the Websense end-user registration portal.
https://www.mailcontrol.com/enduser/reg/index.mhtml
+ Enter your name and email address and click Submit.

+ When you receive an email from Websense, click the link it contains.

If using bulk registration
You will receive an email containing alink that you should click.
If using basic authentication:

This takes you to the Websense end-user registration portal. Enter the password that
you want to use when you access the Web (twice), and click Submit.

Registration is now complete, and you are not required to register again. To check that
you are correctly registered, shut down al browsers and open a new one. When you
try and access a Web site, you are first asked to log in. Type the email address and
password that you used to register with Cloud Web Security and click OK. You may
want to check the box that invites you to save these login details to simplify future
logins.

If using NTLM transparent identification without directory synchronization:

+ Thistakesyou to the Websense end-user registration portal. Enter the password
that you want to use when you access the Web (twice), and click Submit.

+ Now enter aURL, such as www.websense.com, into your browser address bar and
you are presented with the final registration page.

+ Typethe email address and password that you used to register with Cloud Web
Security into the appropriate boxes.

If using basic authentication:

L ogging in when you access the Web
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You need to log in every time you open a new browser to access the Internet. If you
leave your browser open, you are not required to log in again. If you need a second
browser window, do not launch a new browser. Inyour existing one, click File> New
Window. This opens a new browser session without you having to log in again.

For remote users who use Cloud Web Security with basic authentication when
working remotely:

Accessing the Internet when you are not in the office

When you are working in the office, Websense Cloud Web Security isableto
recognize that you work for COMPANY NAME and can protect you from Internet
threats according to our policy. To ensure that you are still protected when you are not
working from the office, when you access the Internet, you are asked to log in. You
must use the email address and password that you entered during Cloud Web Security
registration before you can continue.
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